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(NOTA: Si no sabe qué es Metatrader , le recomiendo que eche un vistazo a este articulo antes de empezar con éste)
Lo primero de todo, recordemos qué podemos hacer utilizando este lenguaje. Con MQL4 podemos crear:

Scripts: se trata de secuencias de comandos que permiten tareas de forma automatizada.
Custom Indicators: se trata de los indicadores que nosotros disefiemos.

Expert Advisors: o lo que es lo mismo, sistemas de trading automaticos.

Libraries: son conjuntos de funciones creadas para desarrollar una tarea especifica.

En este primer articulo, vamos a ver como se crean sencillos scripts y simultdneamente iremos viendo los fundamentos béasicos de
este lenguaje. Para ello, utilizaremos el editor de MQL que incorpora Metatrader, denominado MetaEditor 4. Para arrancarlo, basta
con entrar en Metatrader y presionar la tecla F4. Una vez dentro de MetaEditor vamos a File->New. Nos aparecera el siguiente
asistente:

Expert Advisor Wizard — kil ﬂ[

Welcome to Expert Advisor Wizard

ml ﬂ Please sslectwhat you would ke 1o creste

Expert Advisor
Cuslom Indicator
Seript

Libsrary

Include [ MQH])

O 08 B 0 0

Genarala from lemplata
| 7|

To continue. clck Mext

< Birae Siguiente > Cancelar

Seleccionamos Script y le damos a Siguiente. En la siguiente ventana introducimos los datos que nos pide y le damos a Finalizar:

Exparrt Audwisor Wirard N __IJ XI

General properies of the Scripl program
Please specify general propemses of the Script program

Mame: [ Trader

Authar |J’.-Tr3dEI

Linkc bty fwswews x-radegnet

Parameters: | Hame | Type Irital vefue

£; ..,-|. fi I

< Atrds lTllIEI.I’I Cancelar I

Con ello inicializamos la ventana del script para empezar a programar en ella:
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fproperty copyright "X-Trader"®
fproperty link "htrp: /e X-trader . net®
int start (]
return (0] ;
<] _H

Observe que hay algunas lineas en gris que vienen precedidas por el simbolo “//”. Ello significa que estan comentadas y que seran
ignoradas de cara a procesar los comandos; en particular, delante de cualquier linea en la que pongamos el simbolo “//” podremos
introducir nuestros propios comentarios.

Cadigo Fuente, Compilacion y Otras Cosas del Monton

Por si alguno no lo sabe todavia: lo que vamos a escribir en MetaEditor se denomina cdédigo fuente, es decir, se trata de una
secuencia de comandos que nosotros podemos comprender al estar escrito en un lenguaje de programacién. Sin embargo,
Metatrader no lo comprendera a menos que lo traduzcamos a su propio idioma. Esta traduccién de comandos, denominada
compilacion, se consigue pulsando la tecla F5 en MetaEditor. Una vez compilado el cédigo, se genera un archivo especial que es
el que lee Metatrader.

Una vez compilado un script, bastara con que vayamos a Metatrader y entremos en el menu View->Navigator. En la ventana que
nos aparecera a la izquierda del grafico, haremos click en Scripts y se desplegara la lista de todos los que tengamos. Haciendo
doble click en ellos ejecutaremos la secuencia de comandos que hayamos creado.

Bien, volvamos a la ventana de Metaeditor donde teniamos el punto de partida del script. Los comandos que deseemos incluir
deben escribirse siempre entre las lineas int start(){ y return(0);}

Variables

Ahora que ya sabemos donde escribir, veamos cémo introducir variables. Basicamente el esquema que debemos usar es el
siguiente:

[tipo variable] [nombre variable] = [valor variable];

Dentro de los tipos de variables tenemos los siguientes: int (entero), double (doble precision), string (cadena de texto) y bool
(booleano).

Veamos un ejemplo: si deseamos definir el tamafio de un stop para el EUR/USD. Para ello, podemos escribir:
double stoplosseurus = 0.0025;

En algunos casos, puede que no sea necesario asignar un valor inicial a la variable; asi por ejemplo podemos escribir
simplemente:

double stoplosseurus ;
Y asignarle posteriormente un valor.

Conviene recordar que en MQL4 se distingue el uso de mayusculas y mindsculas por lo que las siguientes expresiones:
double HIGHPRICE; double highprice; double HighPrice; double highPrice;

declararan cuatro variables diferentes.
Asimismo, los nombres de las variables no pueden comenzar por nimeros o simbolos.

Por dltimo hay que tener en cuenta que las palabras del lenguaje MQL4 deben ir siempre en mindsculas. Por ejemplo, las
expresiones:
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DOUBLE hightPrice1; Double hightPrice2;

produciran un error al compilar.

Una vez declaradas las variables, veamos qué se puede hacer con ellas:
Operaciones aritméticas

/IDeclaramos variables para el ejemplo

double a = 50.0;
double b = 2.0;
double c;

// Suma(+): en la variable ¢ sumamos los valores de a y b, obtenemos el valor 52.0
c=a+b;

/I Resta(-): en la variable ¢ restamos los valores de a y b, obtenemos el valor 48.0
c=a-b;

// Multiplicacién(*): en la variable ¢ multiplicamos a por b, obtenemos el valor 100.0
c=a'b;

// Division(/): en la variable ¢ dividimos el valor de a por b, obtenemos el valor 25.0
c=alb;

// También podemos combinar operaciones tal que ¢ ahora valdria 104.0
c=(a+b)"b;

Generacion de ventanas con mensajes

Todas las operaciones que acabamos de ver son realizadas correctamente cuando ejecutamos este script en Metatrader. Sin
embargo, al ejecutarlo no tendremos ninguna confirmacién visual de que todo va bien. Para ello, necesitamos utilizar una funcién
muy Util, MessageBox().

Mediante dicha funcién podemos generar ventanas con mensajes informativos del estado de una secuencia de comandos. El
esquema para utilizar esta funcion es el siguiente:

MessageBox("Mensaje que queremos mostrar.","Titulo de la Ventana");

Veamos un ejemplo de cémo podriamos utilizar esta funcién con el siguiente cédigo:
int a = 50;

int b =100;

MessageBox("Muy facil. a+b=" + (a + b), "Resultado de la Suma");

Como resultado obtenemos la siguiente ventana:

X

Muy fécil. a+b=150

Aceptar |

Vectores (Arrays)
Pasamos a ver como se declaran vectores en MQL. El esquema para ello es el siguiente:

(Tipo de array) (Nombre del array) [N® de elementos];
Por ejemplo, la sentencia:

double price[5];

nos creara un vector de 5 elementos de tipo Double.

¢, Coémo podemos hacer referencia a cada uno de los componentes del array y darles un valor? Muy fécil: una vez hemos
declarado el array "price" del ejemplo anterior, podemos dar un valor a su primer elemento de la siguiente forma:

price[0] = 1.2341;

Obsérvese que los indices de los arrays empiezan en 0, de tal forma que dicho valor se corresponde con el primer elemento del
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array. Del mismo price[1] = 1.2321; nos asignaria un valor al segundo elemento del array y asi sucesivamente.
Por supuesto, podemos declarar un array asignandole valores iniciales:

double price[2] = {1.2234, 1.2421};

Aunque también es posible no especificar el nimero de elementos y dejar que Metatrader lo determine:
double price[] = {1.2234, 1.2421};

Asimismo, con los arrays también podemos realizar las mismas operaciones que haciamos con las variables como se muestra en
los siguientes ejemplos:

double price[2];

price[0] = 1.2234;

price[1] = 1.2421;

MessageBox("El precio medios es " + (price[0] + price[1]) / 2.0,"Precio medio");

Variables y Arrays de Serie
En el lenguaje MQL, existe una serie de variables y arrays que vienen de serie y que nos seran de gran utilidad a la hora de crear
nuestro propio cédigo:

double Open[]; // array de precios de apertura
double High[]; / array de méaximos

double Low[]; // array de minimos.

double Close[]; //array de precios de cierre
double Volumel]; // array de volimenes.
double Bid // Ultimo precio de compra

double Ask // Ultimo precio de venta

Por supuesto, podemos hacer referencia a un determinado valor del array; asi, por ejemplo, High[0] hace referencia al ultimo
maximo del precio. El siguiente grafico seguramente termine de aclararles del todo el asunto:

Como pueden observar cada barra esta indexada, siendo la barra 0 la Ultima, la barra 1 la penultima, etc.

Bucles

Veamos ahora como crear una estructura de bucle (loop) en MQL. Recordemos que este tipo de estructura puede ser tipo For o
While; ésta Gltima la veremos en préximos articulos.

La estructura general de un bucle de tipo For en MQL es la siguiente:

for(Declaracién de Contador; Condiciones para el bucle; Incremento del contador)

Codigo que se ejecutara en el bucle

Veamos en detalle la estructura anterior:
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Declaracion del Contador: siempre utilizaremos una variable de tipo int para el contador, que normalmente siempre sera
inicializada en 0.

Condiciones para el bucle: aqui indicaremos la condicién o condiciones que, en caso de verificarse, permitiran que el bucle
continle ejecutandose; en caso contrario, el bucle finalizara.

Incremento del contador: aqui indicaremos en qué cantidad se incrementara el contador cada vez que termine un bucle.
Normalmente, salvo que sea un caso especial, afadiremos una unidad al contador lo que se consigue anadiendo dos signos
positivos (++) detras del nombre de la variable que actliie como contador.

Seguramente un ejemplo aclare todo esto: supongamos que queremos calcular la media de todos los maximos que hay en el
grafico; lo hariamos del siguiente modo:

//Declaramos una variable para almacenar los maximos y la media

double CumHigh = 0.0;
double AveragePrice=0.0;

// Iniciamos el bucle: damos valor inicial 0 a la variable contador a, produciéndose el final del bucle se alcance el
// nimero total de barras que haya en el grafico (Bars) y sumando una unidad a en cada iteracion.
// En la variable CumHigh sumamos la barra de a periodos atras.

for(int a = 0; a < Bars; a++)
{ CumHigh += Highla]; }

// Calculamos la media dividiendo la suma total entre el n® de barras
AveragePrice = CumHigh/Bars;
Condiciones

Veamos ahora como se construyen condiciones en MQL. Basicamente la estructura es similar a la de otros lenguajes, utilizando la
palabra If, por lo que un ejemplo deberia ser suficiente para entenderlo:

inta=10;

intb=0;

if(a>10)

{ b=1; }
else

{ b=2; 1}

MessageBox("b=" + b,".");

En el ejemplo anterior, la condicion viene entre paréntesis después de la palabra If. Dado que la condicion es falsa (ya que a es
igual a 10), al final del script, el valor de b sera 2 ya que si no se verifica la condicion pasamos al valor Else, que es el que nos
determina qué sucedera si a es menor o igual a 10.

En MQL podemos utilizar diferentes operadores para realizar comparaciones: == (igual), != (distinto), > (mayor) , < (menor) , >=
(mayor o igual) y <= (menor o igual).

Veamos un ejemplo en el que ahora se incluye un bucle dentro de una condicién:

int a=0;

double b=0.0;

bool €;

if(a==0)

{ for(int c=0;c<Bars;c++)
{ b+=Highlc]; }
if(b>500.0)

{ e=true; }

else

{ e=false;} }

El cédigo anterior suma los maximos del gréafico si a es igual a 0; posteriormente si la suma es superior a 500.0 devuelve el valor
verdadero mediante la variable e, o falso en caso contrario.

Por supuesto, las condiciones se pueden superponer unas sobre otras como en el siguiente ejemplo:

int a=0;

int result;
if(a==0)
{result=1;}
else if(a==1)
{ result=2; }
else if(a==2)
{ result=3; }
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else { result=4; }

Las condiciones se pueden complicar ain més introduciendo los valores I6gicos && (AND) y || (OR). Por ejemplo:

int a=10;

int b=20;

if (((@>5) || (a<15)) && ( b==20))

MessageBox("Me ha salido bien!","Ejemplo del uso de AND y OR");

En el préximo articulo veremos cémo construir complejas expresiones asi como algunas aplicaciones.

(Continuara...)

Un saludo,
X-Trader

ARadir a ..

Cerrar ventana
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Bucles de tipo while
Las estructuras de tipo while pueden sernos Utiles en muchas ocasiones. Su forma general es:

while(condicion)
{ cddigo a ejecutar mientras se dé la condicién }

La principal diferencia de este tipo de estructura con los bucles de tipo for es que no existe una variable contador. Por tanto, si no
necesitamos un contador podemos ahorrarnos trabajar con for y usar una bucle while. A medida que avancemos en la serie
iremos viendo ejemplos de este tipo de estructura.

Un nuevo tipo de condiciones. El operador switch.

Con el operador switch, podemos ahorrarnos complejas estructuras compuestas por varios ify else. Fundamentalmente la
estructura de tipo switch es utilizada cuando necesitamos realizar una tarea en funcién del valor de una variable. Por ejemplo,
supongamos que deseamos crear un sistema cuyo comportamiento varia en funcién de la situacién en qué esté el mercado. Asi,
declaramos la variable que toma valores enteros, marketState:

int marketState

Que puede tomar los siguientes valores:

1, si el mercado es alcista
2, si el mercado es bajista
3, si el mercado esta sin tendencia

Si ahora crearamos el sistema combinando varios ify else tendriamos que:

if (marketState == 1)
{ /] Estrategia Mercado Alcista }
else if(marketState == 2)

{ /| Estrategia Mercado Bajista }

else if(marketState == 3)

{ / Estrategia Mercado sin Tendencia }

else { // Error: no se consideran otras posibilidades }

Como podemos ver, todas las condiciones dependen de una Unica variable y en todas se compara su valor con un significado
asociado a él. En este tipo de situaciones, las estructuras de tipo switch son mucho més eficaces:

switch(marketState)

case 1: // Estrategia Mercado Alcista

break;

case 2: // Estrategia Mercado Bajista

break;

case 3: // Estrategia Mercado sin Tendencia

break;

default: // Error: no se consideran otras posibilidades
break;

}

Obsérvese en el ejemplo anterior que hemos definido previamente la variable de estado marketState.
En general, las estructuras de tipo switch presentan la siguiente forma:

switch(variable de estado)
{ case[valor de la variable]:  // Cédigo a ejecutar para este caso

break;

case [otro valor de la variable]: // Codigo a ejecutar para este caso
break;

default:  // Codigo para el resto de casos

break; }

Mas operadores: continue y break
Acabamos de ver en la estructura switch el uso del operador break. Pero break puede utilizarse no sélo dentro de una estructura
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de ese tipo sino en general para salir de cualquier tipo de bucle. Por ejemplo, supongamos que necesitamos saber cual es la
Ultima barra hasta la que el volumen negociado acumulado ha sido mayor o igual a 1000. Para ello podemos utilizar el siguiente
codigo:

inta=0;
double volume = 0.0;
while(a < Bars)

// Si la variable volume supera 1000 points, salimos del bucle while
if(volume > 1000.0)

break;

volume = volume + Volumela];

// Alternativamente para acumular valores en una variable también
/I podemos escribir también volume += Volumela];

a++; |}

El otro operador relacionado con este tipo de tareas es continue, el cual se utiliza para omitir iteraciones no deseadas.
Supongamos que queremos obtener el volumen total de las barras mostradas en el grafico pero ignorando aquellas barras cuyo
volumen sea superior a 50. Para ello, utilizariamos el siguiente cédigo:

inta=-1;

double volume = 0.0;

while(a < Bars)

{ a++;

// Si el volumen supera el valor 50, omitimos esa barra
if(Volume[a] > 50.0)

continue;

volume += Volume[a]; }

Escribiendo nuestras propias funciones

Normalmente nos encontraremos con situaciones en las que veremos que se repite el codigo varias veces. Para ahorrarnos
tiempo tecleando podemos crearnos funciones para llamarlas en los momentos que las necesitemos. Veamos un ejemplo para
entenderlo.

Supongamos que deseamos saber el color de la Gltima vela aparecida en el grafico. Para ello, declaramos una variable booleana
(tan s6lo hay dos casos posibles, blanco o negro) tal que:

bool color;
/I Suponemos gue color = false se corresponde con una vela negra
if(Close[0] > Open[0])

color = true;
if(Open[0] > Close[0])
color = false;

Si quisieramos saber el color de la vela en otra region del grafico (por ejemplo, hace 5 velas), deberiamos reemplazar [0] por el
valor correspondiente. Pero qué pasaria si necesitaramos hacerlo para todas las velas del grafico? Es en este tipo de situaciones
en las que necesitamos recurrir a funciones. Vamos a crear una funcién que nos permitira determinar el color de cualquier vela:

bool color;
color = GetColor(0);

Como podemos ver, en lugar de imponer la condicién para obtener el valor de la variable color, lo que hacemos es crear una
funcién que nos devolvera el valor (true/false - blanco/negro) y que se llamara GetColor. Obsérvese que posee un argumento (el
cero entre paréntesis) hace referencia a la ultima barra del grafico.

La estructura general de una funcién en MQL4 es la siguiente:
[tipo de valor devuelto] [nombre de la funcién] ([lista de argumentos])
{ /I codigo de la funcion
return([valor a devolver]); }
Veamos como escribiriamos la funcion GetColor:
bool GetColor(int index)

{  bool color;
if(Close[index] > Openlindex])

color = true;
if(Open[index] > Close[index])
color = false;

return(color); }

Seguramente les llame la atencion la primera linea, en la que aparece int index entre paréntesis. Sin embargo, cuando llamamos a
la funcion, habiamos escrito simplemente GetColor(0). Qué es lo que ocurre? Sencillamente que cuando hemos escrito la funcion,
hemos definido con la variable index el tipo de argumento que recibira la funcién (en este caso de tipo int — Entero).

Por supuesto, si necesitaramos méas argumentos porque estuviéramos escribiendo una funcién mas compleja, simplemente
bastaria con introducirlos separados por comas. Por ejemplo:
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bool FuncionComplicada(int Argumento1, int Argumento2, string Argumentostring)

Si quisieramos que la funcién no devuelva ningun valor utilizaremos el comando void:

void function() { //code }

También podemos establecer valores por defecto para los argumentos de la funcién. Por ejemplo:

void FuncionA(int argumento1, int argumento2, int argumentoespecial = 50)
{ //code }

Si tuvieramos que llamar a la funcién FuncionA, no seria necesario pasarle un valor al tercer argumento (argumentoespecial) ya
que tiene asignado un valor igual a 50 por defecto.

En todo caso, debemos recordar que los argumentos que tengan valores asignados por defecto deben aparecer siempre al final
de la lista de argumentos.

Arrays multidimensionales
En MQL4 también podemos trabajar con arrays de varias dimensiones, es decir, matrices de datos. Un ejemplo de array
multidimensional seria el siguiente:

[0] 10 20 30
[1]40 50 60
[2] 70 80 90

(01 111 [2]

Los nimeros que aparecen entre corchetes indican cémo son los indices utilizados para referenciar filas y columnas en MQLA4.
Asi, el elemento [0] [1] seria 20, el elemento [1] [2] seria 60 y asi sucesivamente.

Para crear una matriz como la anterior en MQL4, tenemos el comando array2D[num filas] [num columnas] tal que:
int array2D[3][3]=
{10,20,30,

40,50,60,
70,80,90};

También podemos crear arrays en 3D mediante el siguiente comando:
int array3D[num x][num y][num z] = {lista de nimeros separada por comas};

Algunas funciones adicionales para trabajar con arrays serian las siguientes:
Obtener el numero de elementos de un array: int ArraySize(objeto array[]);
Asignar valores a un array: int Arraylnitialize(objeto array[],double valor);

Valor maximo y minimo de un array:

int ArrayMaximum(double array[], int count = WHOLE ARRAY, int start = 0);
int ArrayMinimum(double array[], int count = WHOLE_ARRAY, int start = 0);

Calcular la dimensién de un array: int ArrayDimension(objeto array[]);
Ordenar los elementos de un array:

int ArraySort(double&array[], int count = WHOLE_ARRAY, int start = 0, int sort_dir = MODE_ASCEND);

Copiar un array dentro de otro:

int ArrayCopy(object&dest[], object source[], int start_dest = 0, int start_source=0, int count=WHOLE_ARRAY);
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Preprocesadores
Terminamos la entrega de hoy con lo que se conoce como preprocesador. Veamos en qué consisten con un sencillo ejemplo.
Hace algunos parrafos veiamos la siguiente estructura de tipo switch:

switch(marketState)

case 1: // Estrategia Mercado Alcista

break;

case 2: // Estrategia Mercado Bajista

break;

case 3: // Estrategia Mercado sin Tendencia

break;

default: // Error: no se consideran otras posibilidades
break;

}

Qué les pareceria poder cambiar los valores 1, 2 y 3 por las palabras Alcista, Bajista y Plano? Realmente el codigo seria aln mas
comprensible, verdad?

Pues bien, para poder hacer eso simplemente basta con definir preprocesadores de la siguiente forma: al comienzo del cédigo,
insertariamos las siguientes lineas:

#define ALCISTA 1

#define BAJISTA 2

#define PLANO 3

Como podemos observar, los preprocesadores siempre van precedidos del simbolo #.

Mediante este cddigo lo que hacemos es que, por ejemplo, cada vez que aparezca la palabra ALCISTA en el cédigo a compilar,
ésta sera reemplazado por el valor 1.

Para comprobarlo, creen un nuevo script e introduzcan el siguiente codigo para luego ejecutarlo:

/+

/| Preprocesador.mqg4 |
/| X-Trader.net |
/ I
11+ +

#property copyright "X-Trader.net"
#property link  "http://www.x-trader.net"

#define ALCISTA 1
#define BAJISTA 2
#define PLANO 3

11+ +
//| script program start function
11+ +
int start()

{

MessageBox("ALCISTA="+ ALCISTA + " BAJISTA=" + BAJISTA +
" PLANO=" + PLANO);
return(0);

}

(Continuara...)

Un saludo,
X-Trader

ARadir a ..
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Cerrar ventana
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Retomamos la serie sobre programacion en MQL4. En esta tercera entrega pasamos a ver las principales funciones matematicas
de que disponemos en este lenguaje, asi como algunas funciones adicionales para mostrar informacién en pantalla.

FUNCIONES MATEMATICAS

MathAbs (Valor Absoluto)
Esquema: double MathAbs(double value)
Ejemplo:

int a=-10;
a=MathAbs(a); / ahora a vale 10

MathCeil (Redondeo por exceso)
Esquema: double MathCeil(double x)
Ejemplo:

double a;
a=MathCeil(1.001); // dado que se redondea por exceso, a valdra 2.0

MathFloor (Redondeo por defecto)
Esquema: double MathFloor(double x)
Ejemplo:

double a;
a=MathFloor(1.999); // dado que se redondea por defecto, a valdra 1.0

MathRound (Redondeo normal: si la parte decimal es superior a 0.5, se redondea por exceso, en caso contrario por defecto)
Esquema: double MathRound(double x)
Ejemplo:

double a;
a=MathFloor(1.1); // al ser 0.1 menor que 0.5, a valdra 1.0

double b;
b=MathFloor(1.8); // al ser 0.8 mayor que 0.5, a valdra 2.0

MathMax (Maximo de una serie)
Esquema: double MathMax(double valor1, double valor2)
Ejemplo:

double a;
a=MathMax(50.0,1.0); // a toma el valor 50.0

MathMin (Minimo de una serie)
Esquema: double MathMin(double valor1, double valor2)
Ejemplo:

double a;
a=MathMin(10.0,12.0); // a toma el valor 10.0

MathPow (Potencia de un nimero)
Esquema: double MathPow(double base, double exponente)
Ejemplo:

double a;
a=MathPow(5.0,2.0); // a toma el valor 25, es decir, 5 elevado a 2

MathSqrt (Raiz cuadrada de un nimero)
Esquema: double MathSqrt(double x)
Ejemplo:

double a;
a=MathSqrt(9.0); // a es igual a 3, raiz cuadrada de 9
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MathLog (Logaritmo neperiano de un ndmero)
Esquema: double MathLog(double x)
Ejemplo:

double a;
a=MathLog(10.0); // El valor de a es 2.30258509

MathExp (Potencia del nimero e)
Esquema: double MathExp(double d)
Ejemplo:

double a;
a=MathExp(1); // El valor de a es 2.7182818

MathMod (Resto de una division)
Esquema: double MathMod(double Numerador, double Denominador)
Ejemplo:

double a;
a=MathMod(5,2); // Si dividimos 5 entre 2, el resto que queda es a=1.0

MathRand (Generacion de nimeros aleatorios)

Esquema: int MathRand() (esta funcién no tiene argumentos)

Ejemplo: si bien por defecto utiliza el rango de enteros comprendidos entre 0 y 32767, podemos fijar el intervalo en el que
queremos obtener los nimeros de la siguiente forma:

MathRand()%6 // Devuelve enteros aleatoriamente entre 0 (valor 1) y 5 (valor 6).

MathRand()%6+5 // Devuelve enteros aleatoriamente entre 5 (valor 6) y 10 (valor 11)

(MathRand()%11+10)*(-1) // Obtenemos enteros aleatorios entre -10 y -20

(MathRand()%1001/1000.0) // Obtenemos valores entre 0 y 1 con tres decimales

MathSrand (Generacion de nimeros enteros aleatorios iniciando la secuencia en un valor determinado o semilla)

Esquema: void MathSrand(int semilla)

Ejemplo: Esta funcién puede combinarse de forma muy efectiva con la funciéon TimelLocal, que devuelve el nimero de segundos
transcurridos desde el 1 de Enero de 1970 tal que:

MathSrand(TimeLocal());

Con ello, conseguimos dar un valor Unico a la semilla de partida.

Funciones Trigonométricas
En MQL tenemos disponibles las funciones de seno, coseno y tangente asi como sus inversas, esto es, arcoseno, arcocoseno y
arcotangente. El esquema de utilizacién para cada una de ellas es, respectivamente:

double MathSin(double x)
double MathCos(double x)
double MathTan(double x)
double MathArcsin(double x)
double MathArccos(double x)
double MathArctan(double x)

Todas ellas funcionan en base a radianes por lo que conviene convertir cualquier nimero en grados a radianes antes de
introducirlo en estas funciones, de la forma:

Radianes = (Grados * Pi)/180

Suele ser conveniente declarar el nimero Pi como una variable al comienzo de cualquier cédigo con estas funciones. Para ello
escribiremos:

#define Pl 3.1415926535897

OTRAS FUNCIONES PARA MOSTRAR MENSAJES
Hasta ahora sélo habiamos visto la funcion MessageBox para mostrar informacion en pantalla. Veamos algunas funciones mas.

Alert (Emitir una alerta)
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Esquema: void Alert(...)
Ejemplo:

Alert(“Signal Type:"+signaltype);

Recordemos que el sonido de las alertas puede configurarse desde el menu Tools->Options dentro de la pestafha Events.
Comment (Muestra un mensaje en la esquina superior izquierda del gréfico)

Esquema: void Commenty...)

Ejemplo: si escribimos por ejemplo:

Comment(“Recuerda que tiene soporte en 1.5300");

Al ejecutar el codigo que contiene esta instruccion, nos aparecera ese comentario en la parte superior izquierda del grafico.
Print (Permite mostrar mensajes en el registro de un Expert Advisor)

Esquema: void Print( ...)

Ejemplo: si queremos que cuando carguemos un Expert Advisor se nos muestre alguna informacién en pantalla, utilizaremos esta
funcién; por ejemplo:

Print(“"EA cargado correctamente”);

(Continuara...)

Un saludo,
X-Trader

ARadir a .l

Cerrar ventana
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i)

MQL4 para Novatos IV

por X-Trader
06/04/2008

Continuamos con la serie sobre el lenguaje MQL. En esta ocasién se abordan las principales funciones de indicadores técnicos
que trae incorporadas de serie. Todas las funciones que vamos a ver a continuacién constan casi siempre de los siguientes
argumentos:

symbol — define sobre qué par de divisas o valor se aplicar el indicador. Si queremos que pueda usarse en cualquier grafico
daremos valor NULL (o 0) a este parametro. Si queremos aplicarlo a un producto determinado deberemos escribir su nombre
como una cadena ("EURUSD","GBPUSD" etc.).

timeframe — en el segundo argumento se define la escala temporal en la que se va a utilizar el indicador. Si queremos que se
utilice el periodo del grafico sobre el que insertamos el indicador simplemetnte daremos valor 0 a este parametro. Si queremos
especificar el periodo, deberemos utilizar una de las siguientes constantes:

PERIOD_M1 - 1 minuto
PERIOD_M5 - 5 minutos
PERIOD_M15 - 15 minutos
PERIOD_M30 - 30 minutos
PERIOD_H1 - 1 hora
PERIOD_H4 - 4 horas
PERIOD_D1 - 1 dia
PERIOD_W1 - 1 semana
PERIOD_MNT1 - 1 mes

shift — el dltimo argumento define cudl sera el Ultimo valor del indicador que se mostraré en pantalla. Normalmente querremos
que nos muestre el Ultimo valor del indicador por lo que le asignaremos valor 0, pero si queremos que nos muestre valores
anteriores del indicador en la Ultima barra (esto es, queremos retardar el indicador) le asignaremos el valor 1 para mostrar el
valor del indicador en la barra anterior, 2 para mostrar su valor hace dos barras, etc.

Asimismo en los indicadores es habitual utilizar valores calculados a partir de los campos que definen una barra, para después
promediarlos utilizando un método determinado. Para ello se utilizan los siguientes argumentos:

applied_price — define el campo que utilizaremos del precio; para ello utilizaremos las siguientes constantes:

PRICE_CLOSE - Cierre

PRICE_OPEN - Apertura

PRICE_HIGH - Maximo

PRICE_LOW - Minimo

PRICE_MEDIAN — Precio Medio definido como (Max+Min)/2

PRICE_TYPICAL — Precio Tipico, calculado como (Max+Min+Cierre)/3

PRICE_WEIGHTED - Precio ponderado, obtenido a partir de la siguiente férmula: (Max+Min+Cierre+Cierre)/4

ma_method — permite definir el método utilizado para calcular una media mévil. Admite los siguientes valores:

MODE_SMA — Media moévil simple

MODE_EMA - Media mévil exponencial
MODE_SMMA - Media mévil suavizada
MODE_LWMA - Media movil ponderada linealmente

period — define cuantas barras se incluiran para calcular la media

ma_shift — permite desplazar la media un niumero definido de barras. Si el valor introducido es positivo desplazara la media a
la derecha el nimero de barras que hayamos indicado; por el contrario, si el valor es negativo, la media es desplazada a la
izquierda.

Las funciones de indicadores que vamos a ver a continuacion pueden agruparse en dos categorias: simples, cuando sélo constan
de una linea, o complejas, cuando constan de varias lineas. En este Ultimo caso, se utilizara el parametro mode como veremos
mas adelante..

Pasamos a continuacion a ver todas las funciones de indicadores técnicos que incorpora este lenguaje, la forma de utilizarlos y un
ejemplo:

Aceleracion/Deceleracion (AC)
Este indicador mide la velocidad a la que varian los precios.
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Esquema: double iAC(string symbol, int timeframe, int shift)

Ejemplo:

double ac;

ac=iAC(0,0,0); // AC aplicado a la Ultima barra en cualquier grafico de cualquier escala temporal. ac=iAC
("GBPUSD",PERIOD M30,0);

// AC aplicado a la ultima barra del grafico de 30 min. del GBPUSD.

Acumulacién/Distribucion (A/D)

Indicador utilizado para confirmar la tendencia de los precios utilizando el volumen. Debe tener en cuenta que, en el caso de las
divisas, Metatrader muestra el volumen negociado por el broker en su red de negociacién por lo que no tiene porque ser
representativo del volumen negociado a nivel mundial.

Esquema: double iAD(string symbol, int timeframe, int shift)

Ejemplo:
double ad;
ad=iAD("GBPUSD",PERIOD_M5,5); // A/D de hace 6 barras en el grafico de 5 min. del GBPUSD

Alligator
Indicador desarrollado por Bill Williams que combina 3 medias méviles

Esquema:

double iAlligator( string symbol, int timeframe, int jaw_period, int jaw_shift, int teeth_period,
int teeth_shift, int lips_period, int lips_shift, int ma_method, int applied_price,
int mode, int shift)

Obsérvese que aparte de los habituales symbol, timeframe y shift esta funciéon para controlar el periodo y el desplazamiento de
cada una de las tres lineas - mandibula (jaw), dientes (teeth) y labios (lips) - de que se compone el Alligator.

Asimismo incorpora los parametros para seleccionar el tipo de media aplicada (ma_method) y el campo del precio sobre el que se
aplicara (applied_price).

Finalmente si miramos la estructura tenemos un parametro adicional del que por ahora sélo habiamos hecho mencién: mode. Las
constantes que admite este parametro varian dependiendo de la funcién que la utilice y sirve generalmente para seleccionar, en el
caso de los indicadores de tipo complejo, la linea con la que queremos trabajar. En el caso del Alligator admite los siguientes
valores:

MODE_GATORJAW - Mandibula del Alligator (linea azul)
MODE_GATORTEETH - Dientes del Alligator (linea roja)
MODE_GATORLIPS - Labios del Alligator (linea verde)

Ejemplo:

double teeth;

teeth=iAlligator(“EURUSD”,PERIOD H1,128,96,64,0,0,0,MODE_EMA,

PRICE TYPICAL,MODE GATORTEETH,0);

// Calcula los "dientes" linea roja) en un grafici horario del EURUSD.

// Para ell utiliza una media moévil exponencial aplicada a precio tipico

/I Los periodos utilizados para el indicador son 128, 96 y 64. No se aplica desplazamiento.

Average Directional Movement Index (ADX)
Este indicador se utiliza para detectar si hay o no tendencia.

Esquema: double iADX(string symbol,int timeframe,int period,int applied_price,int mode,int shift)
En este indicador, el parametro mode admite los siguientes valores:

MODE_MAIN - Linea principal del indicador

MODE_PLUSDI - Linea +DI

MODE_MINUSDI - Linea —DI

Ejemplo:

double plusDi;

plusDi=iADX(“USDCAD”,PERIOD M1,6,PRICE OPEN,MODE PLUSDI,0);

// Calcula el valor de la linea +DI en el grafico de 1 min del USDCAD utilizando
// un periodo de 6 barras y tomando las aperturas de cada barra.

Average True Range (ATR)
Este indicador permite medir la volatilidad del mercado

Esquema: double iATR(string symbol,int timeframe,int period,int shift)
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Ejemplo:
double atr;
atr=iATR(0,0,15,0); // ATR de 15 periodos del gréafico y escala temporal que deseemos.

Awesome Oscillator (AO)
Desarrollado por Bill Williams, permite determinar el momentum del mercado

Esquema: double iAO( string symbol, int timeframe, int shift)

Ejemplo:

double ao;

ao=iAO("EURAUD”,PERIOD W1,1);

// AO de la pendltima barra calculado en el grafico semanal del EURAUD.

Bears Power
Este indicador trata de estimar el potencial bajista del mercado

Esquema: double iBearsPower(string symbol,int timeframe,int period,int applied_price,int shift

Ejemplo:

double bep;

bep=iBearsPower("EURUSD",PERIOD M5,32,PRICE CLOSE,1);
// Bears Power de la penultima barra calculado sobre 32 cierres

// en un grafico de 5 min. del EURUSD

Bollinger Bands (BB)
Se trata del conocido indicador de John Bollinger, con el que se pretende establecer un rango de movimiento probable para el
precio

Esquema:
double iBands( string symbol, int timeframe, int period, int deviation, int bands_shift,int applied_price, int mode, int shift)

Como puede apreciarse tenemos dos parametros adicionales: deviation, con el que se controla la amplitud de las bandas y
bands_shift, con el que es posible desplazar las bandas. Por supuesto, también contamos con el parametro mode, que admite los
siguientes valores:

MODE_UPPER - Linea superior
MODE_LOWER - Linea inferior

Ejemplo:

double bb;

bb=iBands(0,0,20,2,0,PRICE LOW,MODE LOWER,0);

/I Banda inferior de Bollinger calculada hasta la Gltima barra

// de cualquier periodo y escala. Utiliza 20 barras para la media
/I que se calcula sobre los minimos y la desviacion utilizada es 2

Bulls Power
Este indicador trata de estimar el potencial alcista del mercado

Esquema: double iBullsPower(string symbol, int timeframe, int period, int applied_price, int shift)

Ejemplo:

double bup;

bup=iBullsPower(0,0,10,PRICE CLOSE,1);

// Bears Power de la penultima barra calculado sobre 10 cierres
// en un grafico y escala cualesquiera.

Commodity Channel Index (CCl)
El CClI se utiliza para medir la desviacion del precio con respecto a su media

Esquema: double iCCI( string symbol, int timeframe, int period, int applied_price, int shift

Ejemplo:

double cci;

cci=iCCI(0,0,14,PRICE TYPICAL,0);

// CCl de 14 periodos calculado sobre el precio tipico
// para cualquier grafico y escala.

DeMarker (DeM)
Creado por Tom DeMark, este indicador intenta predecir un giro de mercado basandose en la diferencia del precio con respecto a
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barras anteriores.
Esquema: double iDeMarker( string symbol, int timeframe, int period, int shift)

Ejemplo:

double dm;

dm=iDeMarker("EURJPY",PERIOD H4,51,1);

// Calcula el DeMarker hasta la penultima barra en un grafico de 4 horas
// del EURJPY utilizando un 51 barras.

Envelopes
Con este oscilador es posible crear envolventes del precio en base a una media mévil.

Esquema: double iEnvelopes( string symbol, int timeframe, int ma_period, int ma_method, int ma_shift,
int applied_price, double deviation, int mode, int shift)

Aqui aparece el pardmetro deviation con el que se controla la amplitud de la envolvente en términos porcentuales (por ejemplo, si
asignamos el valor 0.25 diremos que sume y reste el 25% del precio a la media mévil).

Asimismo, dado que el indicador consta de dos lineas, disponemos del parametro mode para seleccionar la linea que deseemos,
utilizando par ello los siguientes valores:

MODE_UPPER - Linea superior
MODE_LOWER - Linea inferior

Ejemplo:

double envel;

envel=iEnvelopes(0,0,21,MODE SMA,0,PRICE CLOSE,0.05,MJODE LOWER,0);

// Banda inferior de la envolvente calculada usando una media simple de 21 periodos
/I'y una desviacién del 5% para cualquier grafico y escala

Force Index (FRC)
Este indicador trata de medir la fuerza de la tendencia.

Esquema: double iForce( string symbol, int timeframe, int period, int ma_method, int applied_price, int shift)

Ejemplo:

double force;

force=iForce("EURGBP",PERIOD M5,21,MODE LWMA,PRICE HIGH,1);
// FRC de 21 periodos calculado hasta la penultima barra usando una media
/l linealmente ponderada de los maximos del grafico del EURGBP en 5 min.

Fractals

Se trata de otro de los indicadores de Bill Williams, utilizado para detectar suelos y techos. Dado que el fractal no se da en todas
las barras, esta funcién devuelve el valor cero mientras no se produzca el patron.

Esquema: double iFractals( string symbol, int timeframe, int mode, int shift)

Esta funcion dispone del pardmetro mode para seleccionar el tipo de fractal:

MODE_UPPER - Fractales bajistas (techo de mercado)
MODE_LOWER - Fractales alcistas (suelo de mercado)

Ejemplo:
double frac;

frac=iFractals("USDJPY",PERIOD D1,MODE UPPER,0);
// Fractales bajistas en la Ultima barra de un grafico diario del USDJPY.

Gator Oscillator
El Gator Oscillator se utiliza para mediar el grado de convergencia o divergencia entre las lineas que componen el Alligator.
Esquema:

double iGator( string symbol, int timeframe, int jaw_period, int jaw_shift, int teeth_period,
int teeth_shift, int lips_period, int lips_shift, int ma_method, int applied_price, int mode, int shift)

Dado que se basa en el Alligator, aparecen los parametros para modificar sus mandibulas, dientes y labios. Asimismo cuenta con
el parametro mode para seleccionar la parte del histograma que nos interese:

MODE_UPPER - Histograma positivo (verde)
MODE_LOWER - Histograma negativo (rojo)
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Ejemplo:

double gator;

gator=iGator(0,0,13,8,8,0,0,0,MODE SMA,PRICE CLOSE,MODE UPPER,0);
// Histograma positivo calculado sobre el Alligator de periodos 13,8,8

/I utilizando una media movil simple de los cierres.

Ichimoku Kinko Hyo
Se trata del conocido conjunto de lineas japonés

Esquema: double ilchimoku( string symbol, int timeframe, int tenkan_sen, int kijun_sen,
int senkou_span_b, int mode, int shift)

Como puede observarse cuenta con los parametros para controlar el periodo de cada una de las lineas que compone el indicador
y un parametro mode para seleccionar la linea que nos interese:

MODE_TENKANSEN - Tenkan-sen
MODE_KIJUNSEN - Kijun-sen
MODE_SENKOUSPANA - Senkou Span A
MODE_SENKOUSPANB - Senkou Span B
MODE_CHINKOUSPAN - Chinkou Span

Ejemplo:

double ichi;

ichi=ilchimoku(0,0,13,21,53,MODE KIJUNSEN,0);
/I Valor del Kijun-sen tomando periodos 13, 21, 53.

Market Facilitation Index (BW MFI)
Creado por Bill Williams, este indicador muestra el cociente entre el rango de la barra y el volumen negociado en dicha barra.

Esquema: double iBWMFI( string symbol, int timeframe, int shift

Ejemplo:
double bwmfi;
bwmfi=iBWMFI(0,0,0); // BWMFI calculado para la Ultima barra del chart que tenemos en pantalla.

Momentum
El Momentum permite calcular la variacion entre dos cierres separados x barras

Esquema: double iMomentum( string symbol, int timeframe, int period, int applied_price, int shift)

Ejemplo:

double mom;

mom=iMomentum(0,0,12,PRICE CLOSE,1);

// Momentum de 12 periodos calculado hasta la penultima barra.

Money Flow Index (MFI)
Este indicador mide la entrada y salida de dinero en el mercado

Esquema: double iMFI( string symbol, int timeframe, int period, int shift

Ejemplo:

double mfi;

mfi = iMF1(0,0,14,0);

// Calcula un MFI de 14 periodos para el grafico actual.

Moving Average (MA)
Calcula una media movil utilizando el método indicado sobre el campo del precio que deseemos.

Esquema: double iMA( string symbol, int timeframe, int period, int ma_shift, int ma_method, int applied_price, int shift)

Ejemplo:

double ma;

ma=iMA("EURCHF",PERIOD M15,21,6, MODE LWMA,PRICE LOW,1);

// Calcula la media mévil linealmente ponderada de 21 periodos en el grafico de 15 min.
// del EURCHF hasta la pendltima barra y la desplaza 6 barras hacia la derecha.

Moving Average Convergence/Divergence (MACD)
EI MACD es un indicador que trata de determinar la tendencia en base a dos medias exponenciales.
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Esquema: double iMACD( string symbol, int timeframe, int fast_ema_period, int slow_ema_period, int signal_period, int
applied_price, int mode, int shift)

En este esquema los parametros fast_ema_period, slow_ema_period y signal_period controlan el valor de las medias moviles
utilizadas en el indicador. Asimismo el parametro mode permite seleccionar la linea que nos interese asignando uno de estos
valores:

MODE_MAIN - Linea principal
MODE_SIGNAL - Linea Signal

Ejemplo:

double ma;

ma=iMACD(0,0,9,21,9,PRICE CLOSE,MODE MAIN,0);

// Valor de la linea principal del MACD en el grafico actual, utilizando pardmetros, 9, 21 y 9.

Moving Average of Oscillator (OsMA)
El OsMA permite calcular la diferencia entre la linea principal y la linea signal del MACD
Esquema:

double iOsMA( string symbol, int timeframe, int fast_ema_period, int slow_ema_period,
int signal_period, int applied_price, int shift)

Ejemplo:

double osma;
osma=iOsMA(0,0,12,26,9,PRICE CLOSE,0);
// OsMA de un MACD de periodos 12,26,9

On Balance Volume (OBV)
Indicador que relaciona el comportamiento del precio con el volumen

Esquema: double iOBV( string symbol, int timeframe, int applied_price, int shift)
Ejemplo:

double obv;
obv=iOBV(0,0,PRICE OPEN,0);
// OBV calculado hasta la dltima barra utilizando la apertura.

Parabolic Stop and Reverse system (Parabolic SAR)
El Parabolic SAR es un indicador que permite definir la tendencia y puntos de entrada y salida.
Esquema: double iSAR( string symbol, int timeframe, double step, double maximum, int shift)

Incorpora los parametros habituales en este indicador: step para definir la aceleracién y maximum para fijar el tope de la
aceleracion.

Ejemplo:

double sar;

sar=iSAR(0,0,0.02,0.2,0);

// Parabolic SAR con aceleracién 0.02 y tope 0.2.

Relative Strength Index (RSI)

Se trata del conocido indicador de Welles Wilder para detectar puntos de giro en el mercado.
Esquema: double iRSI( string symbol, int timeframe, int period, int applied_price, int shift)
Ejemplo:

double rsi;

rsi=iRSI("USDCAD",PERIOD M1,9,PRICE OPEN,0);

// Calcula un RSI de 9 periodos en el grafico de 1 min. del USDCAD utilizando
// datos de apertura.

Relative Vigor Index (RVI)
EL RVI es un indicador muy similar al Estocastico que trata de detectar giros de mercado.

Esquema: double iRVI( string symbol, int timeframe, int period, int mode, int shift)

El indicador consta de dos lineas por lo que requiere del parametro mode, que admite los siguientes valores:
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MODE_MAIN - Linea principal
MODE_SIGNAL - Linea signal

Ejemplo:

double rvi;

rvi=iRVI(0,0,12,MODE MAIN,1);

// Calcula la linea principal de un RVI de 12 periodos hasta la penultima barra.

Standard Deviation
Con este indicador se calcula la desviacion tipica del mercado, con objeto de medir su volatilidad.

Esquema: double iStdDev( string symbol, int timeframe, int ma_period, int ma_shift, int ma_method, int applied_price, int shift)
Ejemplo:
double sd;

sd=iStdDev(0,0,10,0,MODE SMA,PRICE CLOSE,0);
// Calcula la desviacién tipica de 10 periodos utilizando una media movil simple.

Stochastic Oscillator
El Estocastico es un indicador con el que se intenta detectar puntos de giro del mercado.

Esquema: double iStochastic( string symbol, int timeframe, int %Kperiod, int %Dperiod, int slowing, int method,
int price_field, int mode, int shift)

Aqui aparecen algunos parametros que controlan el comportamiento del Estocastico: asi %Kperiod es el periodo de la linea %K,
%Dperiod es el de la linea %D y slowing es el periodo de la media moévil que suaviza la linea %D.

Por su parte, el parametro price_field admite dos valores: 0, para tomar minimos y maximos en el célculo, 6 1 si queremos que
solo utilice los cierres.

Finalmente dado que el Estocéstico consta de dos lineas contamos con el parametro mode que admite los siguientes valores:

MODE_MAIN - Linea principal
MODE_SIGNAL - Linea Signal

Ejemplo:
double s;
s=iStochastic(0,0,10,6,6, MODE SMA,0,MODE MAIN,0);

// Calcula el valor de la linea principal del Estocastico de parametros 10,6,6
/I Para ello, utiliza una media simple y maximos y minimos

Williams’ Percent Range (%R)

Indicador que funciona de manera similar al Estocastico desarrollado por Larry Williams
Esquema: double iWPR( string symbol, int timeframe, int period, int shift)

Ejemplo:

double wpr;

wpr=iWPR("USDCHF",PERIOD D1,9,0);
// Calcula un WPR de 9 periodos en el gréafico diario del USDCHF.

(Continuara...)

Un saludo,
X-Trader

ARadir a .l

Cerrar ventana
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MQL4 para Novatos V

por X-Trader
11/04/2008

Bien, pasamos a la accién: si Vd. ha seguido el curso desde el principio, no deberia tener problemas para crear su primer
indicador en MQLA4.

Eso si, antes de ponernos manos a la obra es preciso repasar qué caracteristicas poseen los indicadores en Metatrader:

Por un lado, existen indicadores que se dibujan sobre el propio grafico, constan de una o varias lineas, sus valores pueden ser
ilimitados y se representan con un color, grosor y estilo de linea definidos. Este seria el caso de una media movil.

Por otro lado, tenemos indicadores que se dibujan en una nueva subventana mostrando una o varias lineas cuyo color, grosor
y estilo pueden ser definidos, y cuyos valores estan acotados. Tal seria el caso del RSI.

También tenemos indicadores en forma de histograma o que se representan mediante simbolos (flechas, circulos, etc.)

En definitiva podemos decir que un indicador consta de los siguientes parametros:

Una o mas lineas (que en MQL4 se denominan Buffers), pudiendo definir para cada una su aspecto, color, grosor y estilo.
La ventana en la que se trazara (sobre el grafico o en una subventana)

En caso de que el indicador sea dibujado en una subventana, habra que definir si el rango del indicador seré limitado o se
ajustara automaticamente la escala.

Teniendo en cuenta todo esto, comenzamos a crear nuestro primer indicador. Para ello abrimos el Metaeditor tecleando F4 y
vamos a File->New. Se nos abrira un asistente en el que debemos seleccionar Custom Indicator y darle a Siguiente. A
continuacion rellenamos los campos de Name, Author y Link. Justamente debajo de esos campos vemos un espacio en blanco
que pone Parameters. Ahi podemos afnadir variables que después se pueden modificar para que cualquier usuario pueda hacer
cambios en los valores que definen el indicador.

Para nuestro ejemplo, pulsamos en Add y pondremos como nombre al parametro, barsToProcess, y fijando su valor por defecto
igual a 100, dejando el tipo de variable como int (entero). Le damos a Siguiente.

Ahora se nos piden dos cosas: por un lado, si queremos tener el indicador en una ventana aparte (para lo cual deberemos marcar
Indicator in separate window) y por otro, el nimero de lineas (Indexes) de que constara el indicador. Debemos tener en cuenta
que aunque pongamos que tiene 5 lineas no tienen porque dibujarse todas: podemos por ejemplo usar 3 para almacenar valores y
2 para representar el indicador en si. Asimismo, el maximo de lineas que podemos poner es de 8. Para afadir una nueva linea
haremos click en Add pero por defecto ya tenemos una, cuyo color podemos modificar (ponemos Azul por ejemplo) asi como el
tipo de representacion (que por ahora dejaremos en Line).

Hacemos click en Finalizar y listo, ya tenemos definidos todos los parametros del indicador. Veamos qué significa el codigo que
acabamos de generar:

El encabezado recoge los datos del autor:

#property copyright "X-Trader"
#property link  "http://www.x-trader.net"

A continuacién se enumeran las propiedades del indicador: debe dibujarse en una subventana, con una linea y en color azul
marino (Navy):

#property indicator separate window
#property indicator buffers 1
#property indicator_color1 Navy

Observese que el pardmetro indicator_color va seguido de un nimero, que se corresponde con la linea (buffer) a la que afecta
(ojo, la enumeracién de los buffers comienza aqui en 1y no en 0 como hasta ahora).

Seguidamente nos muestra los parametros definidos:

//---- input parameters
extern int barsToProcess=100;

Definimos el buffer:

/I---- buffers
double ExtMapBuffer1[];

Ahora comienza el cédigo del indicador en si. Si miramos el codigo completo veremos que consta de tres secciones diferenciadas:
init(), deinit() y start(). Veamos en qué consiste cada una:

init() es una funcién que sélo sera llamada una vez, en el momento de inicializar el indicador. En esta seccidén se comprueba
que los valores de los parametros son correctos y se prepara el indicador para cargar datos. No obstante no es obligatorio
utilizarla por lo que si no lo vamos a usar podemos borrarla.

deinit() se utilizara para indicar qué debe suceder cuando borremos el indicador de un gréfico. De nuevo esta funcién no es
obligatoria.
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start() sera llamada cada vez que aparezca un nuevo tick en el grafico por lo que aqui es donde debemos poner las
instrucciones que permitiran realizar los célculos para obtener el valor del indicador.

Veamos que ha escrito el asistente dentro de cada una de las funciones:

En init() se ha especificado como se dibujara el buffer mediante la funciéon SetindexStyle. En este caso, con DRAW_LINE nos
dibujara una linea. Observese que aqui la enumeracion de los buffers vuelve a ser desde 0. Por su parte la funcion SetindexBuffer
asocia un array al buffer que habiamos definido. Finalmente return(0) finaliza la funcién init():

int init()

/I---- indicators
SetindexStyle(0,DRAW LINE);
SetIindexBuffer(0,ExtMapBuffer1);
)/

return(0);

}

En el caso de deinit() no tenemos nada (generalmente no utilizaremos demasiado esta funcién)

Ahora nos falta decirle qué es lo que debe dibujar. Con lo que vamos a poner dentro de start() vamos a dibujar un indicador que
represente nimeros aleatorios. El c6digo que debe aparecer en esa seccion es el siguiente:

int start()

{int counted bars=IndicatorCounted();
for(int i=0;i<Bars;i++)

{ ExtMapBuffer1[i]l=MathRand()%1001; }
return(0); }

Un poco mas adelante veremos que significa todo esto. De momento vamos a compilar el indicador tecleando F7. Una vez hecho
esto, vamos a Metatrader, abrimos el Navigator (Ctrl+N) y desplegamos Custom Indicators. En esa lista debe aparecer el indicador
con el nombre que le hayan dado. Le seleccionamos, pulsamos botdn derecho en el ratén y hacemos click en Attach to a chart. En
la ventana que nos aparece hacemos click en Aceptar. El resultado deberia ser algo como esto:
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Bien veamos qué significa el cédigo que hemos introducido en start(). Comenzamos con un bucle de tipo for, comenzando en la
Gltima barra (i=0) y finalizando en la primera disponible (i<Bars) incrementando una unidad el contador (i++):

for(int i=0;i<Bars;i++)

En cada iteracién del bucle asignamos a cada elemento del buffer (que se corresponde con la correspondiente barra del gréafico)
un nimero aleatorio entre 0 y 1000:

{ ExtMapBuffer1[i]l=MathRand()%1001; }

Obsérvese que cada vez que entra un nuevo tick, el oscilador cambia por completo ya que depende de la funcién MathRand(). Si
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no quisieramos que esto sucediera (cosa mas que probable ya que el consumo de recursos del ordenador se dispararia)
podriamos utilizar el siguiente codigo:

int start()

{int counted_bars=IndicatorCounted(),
limit;

if(counted bars>0)

counted bars--;
limit=Bars-counted bars;

for(int i=0;i<limit;i++)

{ ExtMapBuffer1[i]l=MathRand()%1001; }
return(0); }

Donde se ha introducido la funcién IndicatorCounted() que nos dice cuantas barras no se han modificado desde que se llamé a la
funcién start(). Ahora el bucle for depende de la variable limit que almacena el niUmero de barras que estan modificandose en el
momento de calcular el indicador.

Finalmente, seguro que recuerdan que hemos introducido un parametro llamado barsToProcess que todavia no aparece en el
codigo. Pues bien, ha llegado el momento de usarlo, veamos el siguiente cédigo:

int start()
{ int counted_bars=IndicatorCounted(),
limit;
if(counted bars>0)
counted bars--;
limit=Bars-counted bars;
if(limit>barsToProcess)
limit=barsToProcess;
for(int i=0;i<limit;i++)
{ExtMapBuffer1[i]=MathRand()%1001;}
return(0); }

Ahora lo que hacemos es comprobar si limit es mayor que barsToProcess. En caso afirmativo hacemos que limit sea igual a
barsToProcess. De esta forma podemos aplicar el indicador a las Ultimas n barras que deseemos.

(Continuara...)

Un saludo,
X-Trader

ARadir a ..

Cerrar ventana
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